<table>
<thead>
<tr>
<th>Title</th>
<th>In Situ Mapping of the Mechanical Properties of Biofilms by Particle-tracking Microrheology</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author(s)</td>
<td>Chew, Su Chuen; Rice, Scott A.; Kjelleberg, Staffan; Yang, Liang</td>
</tr>
<tr>
<td>Citation</td>
<td>Chew, S.C., Rice, S.A., Kjelleberg, S., &amp; Yang, L. (2015) In Situ Mapping of the Mechanical Properties of Biofilms by Particle-tracking Microrheology. Journal of Visualized Experiments, (106), e53093-.</td>
</tr>
<tr>
<td>Date</td>
<td>2015-04-12</td>
</tr>
<tr>
<td>URL</td>
<td><a href="http://hdl.handle.net/10220/39789">http://hdl.handle.net/10220/39789</a></td>
</tr>
<tr>
<td>Rights</td>
<td>© 2015 Journal of Visualized Experiments. This paper was published in Journal of Visualized Experiments and is made available as an electronic reprint (preprint) with permission of Journal of Visualized Experiments. The published version is available at: [<a href="http://dx.doi.org/10.3791/53093">http://dx.doi.org/10.3791/53093</a>]. One print or electronic copy may be made for personal use only. Systematic or multiple reproduction, distribution to multiple locations via electronic or other means, duplication of any material in this paper for a fee or for commercial purposes, or modification of the content of the paper is prohibited and is subject to penalties under law.</td>
</tr>
</tbody>
</table>
**Video Article**

**In Situ** Mapping of the Mechanical Properties of Biofilms by Particle-tracking Microrheology

Su C. Chew, Scott A. Rice, Staffan Kjelleberg, Liang Yang

1Interdisciplinary Graduate School, Nanyang Technological University  
2Singapore Centre on Environmental Life Sciences Engineering, Nanyang Technological University  
3School of Biological Sciences, Nanyang Technological University  
4Centre for Marine Bio-Innovation, University of New South Wales  
5School of Biological, Earth and Environmental Sciences, University of New South Wales  
6School of Biotechnology and Biomolecular Sciences Sciences, University of New South Wales

Correspondence to: Liang Yang at yangliang@ntu.edu.sg


**Keywords**: Bioengineering, Issue 106, Biofilm, particle-tracking microrheology, matrix, bacteria, microscopy, exopolysaccharides.

**Date Published**: 12/4/2015


---

**Abstract**

Bacterial cells are able to form surface-attached biofilm communities known as biofilms by encasing themselves in extracellular polymeric substances (EPS). The EPS serves as a physical and protective scaffold that houses the bacterial cells and consists of a variety of materials that includes proteins, exopolysaccharides and DNA. The composition of the EPS may change, which remodels the mechanical properties of the biofilm to further develop or support alternative biofilm structures, such as streamers, as a response to environmental cues. Despite this, there are little quantitative descriptions on how EPS components contribute to the mechanical properties and function of biofilms. Rheology, the study of the flow of matter, is of particular relevance to biofilms as many biofilms grow in flow conditions and are constantly exposed to shear stress. It also provides measurement and insight on the spreading of the biofilm on a surface. Here, particle-tracking microrheology is used to examine the viscoelasticity and effective crosslinking roles of different matrix components in various parts of the biofilm during development. This approach allows researchers to measure mechanical properties of biofilms at the micro-scale, which might provide useful information for controlling and engineering biofilms.

---

**Video Link**

The video component of this article can be found at [http://www.jove.com/video/53093/](http://www.jove.com/video/53093/)

---

**Introduction**

Most bacterial cells are able to employ both planktonic (free-living) and surface-attached (sessile) modes of growth. In the surface-attached mode of growth, bacterial cells secrete and encase themselves in large amounts of extracellular polymeric substances (EPS) to form biofilms. The EPS mainly consists of proteins, exopolysaccharide, extracellular DNA and is essential to biofilm formation. It serves as a physical scaffold by which bacteria can use to differentiate spatially and protects the bacteria from harmful environmental conditions and host responses. Different components of EPS have distinct roles in biofilm formation and changes in the expression of EPS components can dramatically remodel biofilm structures. EPS components can also function as signaling molecules and recent studies has shown certain EPS components interacting with microbial cells to guide their migration and biofilm differentiation.

Research on the EPS has greatly advanced based upon the morphological analyses of biofilms produced by mutants defective in a specific component of the EPS. In addition, the EPS is usually characterized at the macro-scale (bulk characterization). Morphological analyses however can lack quantitative detail and bulk characterization, which returns average values, loses the detail that exists within the heterogeneity of the biofilm. There is now an increasing trend to progress to real-time characterization of the mechanical properties of EPS at the micro-scale. This protocol demonstrates how particle-tracking microrheology is able to determine the spatiotemporal effects of matrix components Pel and Psl exopolysaccharides on the viscoelasticity and effective crosslinking of *Pseudomonas aeruginosa* biofilms.

Passive microrheology is a simple and inexpensive rheology method that provides the highest throughput of spatial microrheological sampling of a material to date. In passive microrheology, probe spheres are placed in the sample and their Brownian motion, driven by thermal energies ($k_B T$) is followed by video microscopy. Several particles can be tracked simultaneously, and the time-dependent coordinates of the particles follow a conventional random walk. Therefore, on average, the particles remain at the same position. However, the standard deviation of the displacement or the mean squared displacement (MSD) of the particles, is not zero. Since viscous flows fluid, the particle MSD in a viscous fluid grows linearly as time progresses. In contrast, the polymeric crosslinking found in viscoelastic or elastic substances help them to resist flow, and particles become limited in their displacement, leading to plateaus in the MSD curve (Figure 1A). This observation follows the relation $\alpha$MSD($t$)$\propto t^\alpha$, where $\alpha$ is the diffusive exponent that is related ratio of elastic and viscous contributions of the substance. For particles moving in viscous fluids $\alpha$...
- $\alpha = 1$, in viscoelastic substances $0 < \alpha < 1$, and in elastic substances $\alpha = 0$. The MSD may also be used to calculate the creep compliance, which is the tendency of the material to deform permanently over time and estimates how easily a material spreads.

The size, density and surface chemistry of the particle are critical to the correct application of micro rheological experiment and are chosen with respect to the system studied (in this case the polymers of the biofilm matrix, see Figure 1B). Firstly, the particle measures the rheology of the substance with structures that are much smaller than the particle itself. If the substance's structures are of similar scale to the particle, the motion of the particle is perturbed by the shape and orientation of the individual structures. However, if the structures surrounding the particle are much smaller, this effect is small and averaged out, presenting a homogeneous environment to the particle (Figure 1B). Secondly, the density of the particle should be similar to the medium (1.05 g ml$^{-1}$ for water based mediums) such that sedimentation is avoided and inertial forces are negligible. Most particles with polystyrene lattices meet the above criteria. Ideally, the particle does not interact with the polymers of the biofilm matrix as the rheological interpretation of particle MSD is only valid if motion is random, driven by thermal energy and collision with substance structures. This can be observed by checking whether the probe particle tends to bind or bounce off the surface of a pre-grown biofilm. However, despite the lack of attraction to the biofilm, the particles must be able to be incorporated into the matrix. In addition, the physicochemical heterogeneity of the biofilm may result in different particles being more suitable as probes in different regions of the biofilm. Thus, particles of different sizes and surface chemistry should be applied to the biofilm.

As such, the particle MSD is able to provide useful information on how different components contribute to the rheology and spreading of the biofilm. Furthermore, the use of different probes allows one to derive information on the spatial physicochemical heterogeneity of the biofilm. This method can be used to test the effect antimicrobial treatment on the mechanical properties of the biofilm, or applied to mixed species biofilms to investigate how the mechanical properties of the biofilm are changed from introduction of another species. Particle MSDs may also be useful for characterizing biofilm dispersal. Such studies would be helpful in our understanding of biofilms, potentially improving biofilm treatments and engineering of biofilms for useful activities.

### Protocol

**1. Biofilm Cultivation**

1. **Preparation of Bacterial Strains**
   1. 1 day prior to biofilm cultivation, prepare planktonic bacterial cultures by inoculating 2 ml of appropriate growth medium from frozen bacterial culture. Use Luria-Broth medium (10 g L$^{-1}$ NaCl, 10 g L$^{-1}$ yeast extract, and 10 g L$^{-1}$ tryptone) for mucoid *P. aeruginosa* and its Δpex and ΔpseI defective mutants. Incubate overnight at 37 °C and 200 rpm shaking conditions. Dilute overnight cultures to an OD$_{680}$ of 0.40 using a spectrophotometer.

2. **Assemble flow cell setup**, which has been described previously $^{1,4}$, preferably on a mobile station or trolley that can be brought into the microscope room for imaging the flow cell without disassembly.

3. **Prepare sterile growth medium in 2 L or 5 L bottles for each flow cell. Use minimal medium M9 (48 mM Na$_2$PO$_4$, 22 mM KH$_2$PO$_4$, 19 mM NH$_4$Cl, 9 mM NaCl, 2 mM MgSO$_4$, and 0.1 mM CaCl$_2$) supplemented with 0.04% glucose (wt/vol) and 0.2% (wt/vol) casamino acids for *P. aeruginosa* flow cell biofilms.**

4. **Aliquot fluorescent microspheres into microcentrifuge tubes and spin down in sterile H$_2$O for 5 min in centrifuge at 9,391.2 g. Remove supernatant and resuspend in 1 ml growth medium to remove sodium azide (disinfacter) prior to adding to growth medium in 2 L or 5 L medium bottles.**

   **NOTE:** Different sizes of microspheres come in different concentrations and should be diluted accordingly to instructions. For example, disperse 120 µl of 1.0 µm diameter microspheres, 15 µl of 0.5 µm diameter microspheres and 0.96 µl of 0.2 µm diameter microspheres into 2 L of growth medium to give 2.18 × 10$^9$ microspheres ml$^{-1}$ for each particle size.

5. **Attach medium bottle to upstream of flow cell and allow growth medium to flow through entire setup.** Allow bacteria to attach to the coverslip substratum for 1 hr before continuing flow of growth medium at a flow rate of approximately 5.5 × 10$^{-1}$ m sec$^{-1}$ or 8 rpm with a peristaltic pump.

   **NOTE:** Biofilms are usually grown at room temperature (25 °C) for 3-7 days.

6. **Alternatively, for static culture setup, dilute overnight cultures 100 fold in microcentrifuge tubes by adding 10 µl of overnight culture to 1 ml growth medium with particles. Increase the particle concentration in the growth medium for static culture by approximately 500-fold compared to that used for flow biofilms (e.g. wash and resuspend 600 µl of 1.0 µm diameter spheres in 10 ml of growth medium) as flow cell biofilms are constantly replenished with particles but static cultures are not.**

   1. Add 200 µl of diluted overnight culture with particles to the chambers of 8 well slides. Incubate at 37 °C under static conditions.

   **Biofilms are usually grown for 1 day. Replace spent growth medium daily with fresh growth medium with particles if biofilm is grown for more than 1 day.**

**2. Microscopy**

1. On day 3 and 5, switch off flow from peristaltic pump and bring flow cell setup into the microscope room. Clamp tubing near the entrance and exit of the flow cell chambers to prevent drift (a systematic error cause by changes in the environment) from flow. Place the flow cell onto the microscope stage of an upright microscope.

   **NOTE:** Use an inverted microscope for imaging of microwells.

2. Use fluorescent microscopy with 40X oil objective to take videos of microsphere motion embedded in the biofilm at various locations (microcolonies and flat undifferentiated layers) and in different days (day 3 and 5) for temporal and spatial investigations. Take shorter videos with higher frame rate to investigate events occurring within short time scales (e.g. 1.5-3 min videos at frame rate of 25-50 frames per second for fast dynamics), and longer videos with lower frame rate to investigate events over longer time scales (e.g. 15-30 min videos at frame rate of 2.5-5 frames/sec for slower dynamics).
NOTE: A video typically contains 5-10 particles, and is typically of 1.0-2.5 GB in file size. Larger microcolonies may hold more particles. Take 5-10 videos for each category (e.g. 5-10 videos of different microcolonies and of different locations in flat undifferentiated layers). The biofilm has a heterogeneous architecture that may consist of microcolonies, channels, voids and flat undifferentiated layers.

3. Particle Tracking Analysis

1. Obtain particle trajectories by using the plug-in TrackMate in open source software (ImageJ). Download Fiji at http://fiji.sc/Fiji. Open the video with Fiji and under the Plugins menu, select Tracking and TrackMate.

2. Check or adjust settings in the window suggesting initial calibration settings to match the video parameters as recorded in step 2.4.

3. Detect particles in TrackMate using ImageJ.
   - Select 'LoG detector', input particle diameter and threshold value (e.g. 1,000). Scroll through the video whilst clicking on ‘Preview’ button to check that the purple circles follow the particles throughout the video. Adjust the diameter and threshold values as necessary: increase the threshold value if purple circles appear in the empty space. Reduce the threshold value if not enough particles are detected. Click the next button to complete detection the particles.
   - Click the next button when presented with the option to add or remove particles detected in ‘Initial thresholding’, ‘Select a view’ and ‘Select a filter’ windows to continue without adjustment if initial particle detection was satisfactory.

4. Check that particle tracking is satisfactory by scrolling through the video to see that particles follow the tracks drawn by TrackMate, and that there are no unwanted or missing tracks. Skip the various filtering steps. Go to the final window ‘Select an action’. Select ‘Export tracks to xml file’ from the drop down menu and click ‘Execute’. Choose a folder to save the tracks.

5. Combine particle trajectories from other videos of the same category (e.g. particles embedded in wild-type microcolonies at day 3) by repeating 3.5.1.1 to 3.5.1.4).

6. Plot the ensemble mean or the average over all curves:
   - ma = msdanalyzer(2, 'um', 'sec')
   - Where um and sec are the physical space and time units in the video.

4. Prepare Matlab to import the particle trajectories in the xml files by selecting in the menu of Matlab File>Set Path... and add the scripts folder available with the Fiji package.

5. To analyze the particle trajectories with msdanalyzer, download the link to the zip file or the tar.gz file at http://www.mathworks.com/matlabccentral/fileexchange/40692-mean-square-displacement-analysis-of-particles-trajectories.

1. Extract the @msdanalyzer folder* and drop it in a folder that belongs to the Matlab path (e.g. C:\Documents and Settings\Username>\My Documents\Matlab). Start Matlab and initiate the analyzer by typing:
   - ma = msdanalyzer2('um', 'sec')
   - Where um and sec are the physical space and time units in the video.

   1. Import the particle trajectories by typing:
      - [tracks, md] = importTrackMateTracks('FileName.xml', 'clipZ', 'scaleT')
      - ma = ma.addAll(tracks);
   - Where 'clipZ' removes the z dimension for a 2D video, and 'scaleT'.

      2. Plot the trajectories onto graph using:
         - ma.plotTracks;
         - ma.labelPlotTracks;

      3. Compute the MSDs of the particles using:
         - ma = ma.computeMSD;
         - ma.msd

      4. Plot the MSDs of each particle:
         - figure
         - ma.plotMSD

      5. Combine particle trajectories from other videos of the same category (e.g. particles embedded in wild-type microcolonies at day 3) by repeating 3.5.1.1 to 3.5.1.4).

      6. Plot the ensemble mean or the average over all curves:
         - ma.plotMeanMSD

      Change the y- and x-axis from linear to logarithmic scale. At long lag times, the MSD curves become noisy due to insufficient statistics at longer timescales. The MSD curves may also rise steeply due to dynamic error. These regions of the curve can be removed by using the brush tool to select the end of the curve and selecting ‘Brushing’ > ‘Remove Unbrushed’ in the Tools menu.

2. Download Ezyfit at http://www.fast.u-psud.fr/ezyfit/ and add Ezyfit to a folder belonging to the Matlab path (e.g. C:\Documents and Settings\Username>\My Documents\Matlab). Install the Ezyfit menu by typing in Matlab workspace efmenu install. Restart MATLAB with Ezyfit menu in the figure window. Fit the MSD curves to the power law by selecting in the Ezyfit menu ‘Show Fit’ > ‘Power’ > ‘a*x^n’ were n is the estimated diffusive exponent α.

   NOTE: msdanalyzer requires the Curve Fitting Toolbox in Matlab for fitting of MSD curves. Ezyfit is an alternative and free software that can perform curve fitting.

3. Clear current particle trajectories and MSDs to calculate new particle MSDs at other locations or time: clear
4. After calculation of various mean MSD curves of particles in medium (control), and microcolonies and undifferentiated areas of various strains, copy and paste the curves into one graph for comparison. Sample stiffness and crosslinking increase with lower MSD values. Flat curves have lower $\alpha$ and sample is more elastic than steeper curves with higher $\alpha$.

5. Select the curve and go to "Tools" to look at the data statistics, such as the median and range. The MSD of the bead is proportional to the creep compliance, $J(t)$ of the material in which the bead is embedded according to the relation,

$$J(t) = \frac{3\pi d}{4k_BT} \text{MSD}(t)$$

where $J = \text{creep compliance}$, $d = \text{particle diameter}$, $k_B = \text{Boltzman constant}$, $T = \text{temperature}$ and $t = \text{time}$.

### Representative Results

The local viscoelastic properties of the biofilm in different regions of the biofilm, which included the voids (medium above the biofilm), plains (undifferentiated flat layer of cells) and microcolonies (see labels in Figure 2A) were investigated. The temporal changes in viscoelastic properties of the biofilm during maturation from days 3 to 5 were also determined. The MSD of the particles in the voids was used as a control and comparable to the MSD of particles in pure medium. In contrast, particles trapped in the biofilm vibrated at fixed positions and MSD values ranged from those typical of viscoelastic materials to strongly elastic gels (Figure 3).

Mucoid *P. aeruginosa* wild-type and its Δ*pel* mutant strains (Figure 2A and 2B) developed microcolonies scattered on a thin plain by day 3 in their biofilms. The plain on day 3 was too thin for the investigation of rheological properties. In both biofilms formed by the mucoid *P. aeruginosa* wild-type and Δ*pel* strains, the MSD of particles in the day 3 microcolonies was independent of time for time lags of 0.1 sec to 10 sec ($\alpha = 0$), indicating that the microcolonies were elastic (Figure 4, Table 1). The median creep compliances calculated from the corresponding particle MSDs were $4.3 \times 10^{-2}$ Pa$^{-1}$ and $3.6 \times 10^{-2}$ Pa$^{-1}$ respectively. By day 5 the creep compliance of the microcolonies in mucoid *P. aeruginosa* wild-type strain increased to $2.5 \times 10^{-1}$ Pa$^{-1}$, indicating a reduction in effective crosslinking within the matrix. The day 5 microcolonies were still elastic with $\alpha = 0$. Δ*pel* did not change in rheology from days 3 to 5. The plains in mucoid *P. aeruginosa* wild-type and Δ*pel* strains were similar in elasticity ($\alpha = 0$) and effective crosslinking to day 3 microcolonies, which could be reflective of their maturity (undifferentiated structure).

Biofilms formed by Δ*psl* mutant strain (Figure 2C) were less differentiated and delayed in development. This resulted in biofilms with thick plains that developed microcolonies after day 3. The MSD values showed that the biofilms were much less effectively crosslinked than *P. aeruginosa* wild-type and Δ*pel* strains (Figure 4, Table 1). The plains were viscoelastic, with $\alpha = 0.12$ and 0.26 at days 3 and 5 respectively. The median creep compliance of day 3 and 5 plains was $1.0$ Pa$^{-1}$. When microcolonies had developed in day 5, the creep compliance had decreased to $2.8 \times 10^{-1}$ Pa$^{-1}$, indicating that a threshold crosslinking is required for microcolony differentiation. However, the creep compliance was still greater than the creep compliance of younger day 3 mucoid *P. aeruginosa* wild-type and Δ*pel* microcolonies. The day 5 microcolonies were viscoelastic with $\alpha = 0.34$. Thus, the *P. aeruginosa* biofilm is elastic and highly crosslinked in the absence of Pel. In the absence of Psl, the biofilm became viscoelastic and less crosslinked. In the mature biofilm structures such as the microcolonies, expression of both Pel and Psl exopolysaccharides resulted in distinct rheological differences over time. The reduction in crosslinking could be due to the reduction of Psl to Pel exopolysaccharides in the biofilm matrix during maturation.

![Figure 1: Particle tracking microeology in a biofilm.](image)

(A) Gray circles depict particle MSD in a viscous substance, which grows linearly with time and $\alpha = 1$. Black triangles depict particle MSD of an elastic substance, which is independent of time and $\alpha = 0$. (B) Diagram of probe particle vibrating in the EPS of the biofilm. The particle is modeled like a bacteria cell and is similar in diameter. The matrix polymers that envelop the particle are much smaller than the particle.
Figure 2: Perspective and sectional view of day 5 biofilms (green) by confocal microscopy after continuous feeding with 1.0 µm (purple), 0.5 µm (red) and 0.2 µm (orange) particles with negatively charged carboxylated surface. Biofilms formed from (A) mucoid P. aeruginosa, and mutants (B) Δpel and (C) Δpsl strains. Particles are incorporated in all regions of the biofilm. Examples of microcolonies, plains and voids are labeled in (A). Modified from Chew et al., mBio, 2014. Please click here to view a larger version of this figure.

Figure 3: Particle trajectories. Comparison of a track of a particle executing Brownian motion in growth medium (multicolored) compared to tracks of particles vibrating in biofilm microcolonies (dark blue). The segmented colors indicate breaks in tracking due to particle moving out of focus in the z-plane.
Figure 4: MSDs of 1.0 µm particles in biofilms. Mucoid \textit{P. aeruginosa} is elastic and microcolonies are reduced in effective crosslinking from days 3 to 5; \(\Delta\text{pel}\) is elastic and does not change in rheology from days 3 to 5; \(\Delta\text{psl}\) is viscoelastic and mainly consists of plains that do not change significantly in rheology from days 3 to 5.

<table>
<thead>
<tr>
<th>Strain</th>
<th>Day</th>
<th>Region</th>
<th>Median Creep Compliance (Pa(^{-1}))</th>
</tr>
</thead>
<tbody>
<tr>
<td>wild-type</td>
<td>3 day</td>
<td>Microcolony</td>
<td>4.3 x 10(^{-2})</td>
</tr>
<tr>
<td>wild-type</td>
<td>5 day</td>
<td>Microcolony</td>
<td>2.5 x 10(^{-1})</td>
</tr>
<tr>
<td>wild-type</td>
<td>5 day</td>
<td>Plain</td>
<td>4.1 x 10(^{-2})</td>
</tr>
<tr>
<td>(\Delta\text{pel})</td>
<td>3 day</td>
<td>Microcolony</td>
<td>3.6 x 10(^{-2})</td>
</tr>
<tr>
<td>(\Delta\text{pel})</td>
<td>5 day</td>
<td>Microcolony</td>
<td>3.6 x 10(^{-2})</td>
</tr>
<tr>
<td>(\Delta\text{psl})</td>
<td>5 day</td>
<td>Plain</td>
<td>3.2 x 10(^{-2})</td>
</tr>
<tr>
<td>(\Delta\text{psl})</td>
<td>3 day</td>
<td>Plain</td>
<td>1.0 x 10(^{0})</td>
</tr>
<tr>
<td>(\Delta\text{psl})</td>
<td>5 day</td>
<td>Plain</td>
<td>1.0 x 10(^{0})</td>
</tr>
<tr>
<td>(\Delta\text{psl})</td>
<td>5 day</td>
<td>Microcolony</td>
<td>2.8 x 10(^{-1})</td>
</tr>
</tbody>
</table>

Table 1: Median creep compliances and estimated diffusive exponents of wild-type and mutant strains according to biofilm age and region.

Discussion

Microrheology is a useful tool for local rheological measurements in heterogeneous systems, such as microbial biofilms. It is a non-destructive technique, enabling the real-time monitoring of rheological changes within the same biological sample over multiple time points. In this protocol, particle-tracking microrheology was applied to Pel and Psl exopolysaccharide mutants in order to investigate how they affect the elasticity and effective crosslinking of the biofilm matrix. Pel favors the development of elastic biofilms with high effective crosslinking, whereas Psl favors viscoelastic and looser biofilms. When both exopolysaccharides are produced, the biofilm microcolonies becomes less effectively crosslinked as the biofilm matures, consistent with a decrease in Psl over Pel.

Biofilms formed by different bacterial species have distinct EPS compositions. The EPS of mucoid \textit{P. aeruginosa} strains used in this study mainly consists of exopolysaccharides\(^{16}\). Other species may use large extracellular adhesion proteins\(^{17}\) and DNA\(^{18}\) as their major components of the EPS. The approach described here could be used to determine the rheological contribution of other EPS components and their effect on growth. In addition, biofilms grown in different setups may have drastically different physical properties that affect their rheology. For example, mucoid \textit{P. aeruginosa} supplemented with glucose forms more biofilm with highly differentiated structures under flow compared to static conditions. Studies have also shown that biofilms exposed to shear stress such as flow makes the biofilms more cohesive and elastic\(^{19,20}\). Important steps and factors to consider for successful biofilm particle-tracking microrheology study are as follows:

The system dimensions for investigation or scale of interest with respect to time and space

When considering spatial scales, one must consider the size of the structures that give rise to the viscoelastic properties of the system (in our case, the polymers of the biofilm matrix). The polymers surrounding the probe particle should be much smaller in structure than the particle and present an isotropic environment to the particle. High-resolution imaging is required to capture small particle motion or vibrations, but will reduce the amount of area imaged for equivalent file size. When considering temporal scales, elastic biofilms that exhibit slow dynamics require taking videos over longer time scales (e.g. hr) and using low frame rates (e.g. min). Shorter videos can be taken for viscoelastic biofilms with fast dynamics (min), but require higher frame rates (sec or millisec). Using suitable resolution, frame rate, video duration for each experiment will keep file sizes low for tractable analysis.

Biofilm viscoelasticity, heterogeneity and dimensions

---

---
Particle motion may be undetectable in very elastic biofilms (MSD < 10−4). In such cases, active microrheological techniques that apply force to displace the particle are preferable. Rheological sampling of different regions of biofilm should be made to ensure the mechanical heterogeneity of the biofilm is captured. Heterogeneous morphology, however, is not necessarily a good indicator of mechanical heterogeneity, as despite homogeneous appearances the biofilm can be complex in rheology: Δψ biofilms are more homogeneous in morphology and delayed in differentiation, but have a complex and heterogeneous rheological profile. In contrast, Δεl biofilms have a heterogeneous appearance with well-differentiated microcolonies but a constant rheology throughout the biofilm. For biofilms with large microcolony dimensions (e.g. >50 µm in diameter and height), it may be meaningful study the rheological differences according to height (top and bottom of microcolonies), or distance from microcolony edge.

**Selection of probe particles**

As described above, the size of particles should be larger than the structures of the materials that give rise to its viscoelastic properties. In addition, particles with different surface chemistry may result in binding to different areas and EPS components within the biofilm. Thus the effects of particles with different surface chemistry should be explored so that biofilm heterogeneity can be considered. All probe particles should have a high zeta potential to minimize agglomeration. Particles that bind together cannot be used as accurate probes and should be excluded from analysis.

**Minimization of drift**

Drift can be caused by temperature or air pressure changes, microscope stage movement (usually in the z-direction), anti-vibration table imbalance and internal flow within the system. Drifts usually result in superdiffusion of the particle and \( \alpha > 1 \). An \( \alpha > 1 \) indicates that other than thermal energy, active processes are involved moving particle and passive microrheology is not applicable.

**Proper biofilm culture maintenance**

Flow cells must be properly assembled to prevent leakages and biofilms must be kept free from contamination. Biofilms can also be grown in other setups alternative to the flow cell, such as slides and microwells for static culturing conditions. An inverted microscope should be used for imaging of microwells.

In summary, particle tracking microrheology is a useful technique that can be employed using microscopes standard to a biological laboratory. In addition, programs involved in the calculation and analysis of particle MSDs is readily available in the public domain. For example, msdanalyzer and TrackArt (http://www2.sbs.ntu.edu.sg/staff/rskraut/index.php/trackart) are programs that run in the Matlab environment. However, because the technique relies only on thermal energy to move the particles, it is unable to resolve between samples of higher elasticity. Active techniques, such as magnetic tweezing, apply a force on the particle to act on and move within the sample and would be able to determine the viscoelasticity of highly elastic samples.

**Disclosures**

The authors have nothing to disclose.

**Acknowledgements**

This research is supported by the National Research Foundation and Ministry of Education Singapore under its Research Centre of Excellence Programme, the Start-up Grants (M4330002.C70) from Nanyang Technological University, and AcRF Tier 2 (MOE2014-T2-2-172) from Ministry of Education, Singapore. The authors thank Joey Yam Kuok Hoong for participating in the demonstration of this protocol.

**References**